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Introduction
Leonard Audio - Transmission Line is a loudspeaker modelling program that allows the user to
predict how a given driver will perform in a specific enclosure. The method used differs from
most other modelling software packages in that it is based on a generic 1-dimensional wave
equation meaning that almost any geometry can be modelled and cabinet resonances (in one
direction at least) will be accounted for.
Common loudspeaker enclosure types can be modelled (Sealed, Ported, Band-Pass etc.) as
well as more advanced enclosures (Transmission Line, ML-TL, Horns, Tapped Horns etc.) and
even some complex enclosure that have not been discovered/named yet.
The software is currently in Beta mode and is quickly evolving. Users are encouraged send
comments, suggestions, requests and bug reports to us at peter@leonardaudio.com.uk
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Driver
Upon opening the program for the first time, there will be a popup box asking you to specify or
create a driver directory. Click OK and a directory explorer will pop-up as shown below. Create
and/or specify a driver directory. This is where all the information on different drivers will be
stored.
The program does not have access to some directories so it usually best to have this on folder
directly on the first level of the C: drive.

Once you have created your driver directory the main program window will open up. The
program loads with a default driver and enclosure design. The first thing to do is usually to insert
the parameters of the driver you are attempting to design an enclosure for.

Inserting a Driver
Click on Window > Driver (Ctrl+Alt+D) and the window shown below will popup.

4/27

Meaning of Thiele/Small Parameters
T/S specifications are electromechanical properties that essentially define how a driver will
perform.
● Bl: Force Factor - Product of the magnet field strength in the voice coil gap and the
length of wire in the magnetic field.
● Sd: Projected area of the driver diaphragm.
● Qes: Unitless measurement, describing electrical damping.
● Qms: Unitless measurement, describing mechanical damping.
● Qts: Unitless measurement, describing the combined electric and mechanical damping.
● Cms: Mechanical compliance of the driver suspension.
● Mms: Mechanical mass of the driver's moving parts.
● Lvc: Voice coil inductance.
● Re: DC resistance of the voice coil.
● Fs: Driver resonant frequency.
● Vas: Volume of air having the same stiffness as the driver's suspension.
● Rms: Mechanical resistance of the driver's moving parts.
Inputting Parameters
Simply enter the following parameters into the Driver dialog box and the remaining ones will be
automatically calculated by the software:
Sd, Qes, Qms, Lvc, Re, Fs, Vas
If the calculated values are slightly different to values that you may have, do not worry as these
are rarely large enough to significantly affect the model accuracy.
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You can click on most of the unit labels to cycle through various metric and imperial units.
Click the ‘Update’ button to apply any changes to the model.
Configuration
In this section of the Driver window you are able to apply isobaric loading in either series or
parallel. Isobaric loading is where two identical drivers are coupled together to work as one unit,
as shown in the figure below.

Internally, the software adjusts the thiele/small parameters to create a single driver with the
same parameters as that of two drivers in isobaric loading. The following rules are applied
(internally) to account for isobaric loading:
● Cms’ = 0.5 x Cms
● Mms’ = 2 x Mms
● Rms’ = 2 x Rms
● Re’ (Series) = 2 x Re
● Bl’ (Series) = 2 x Bl
● Lvc (Series) = 2 x Lvc
● Re’ (Parallel) = 0.5 x Re
● Bl’ (Parallel) = 1 x Bl
● Lvc (Parallel) = 0.5 x Lvc

Saving a Driver
When you have input all of the drivers parameters (including a name in the first text box) then
you can save this driver to file so that you can use it again on another project. Click on the
‘Save’ or ‘Save As’ buttons to save the driver you have just entered (Save has the same
function as Save As if no previously entered driver is selected).
Your driver should now appear in the List Box ‘Driver Library’ on the right hand side of the Driver
Window. You can now edit this driver by selected it within the Library List Box (so that it is
highlighted), changing the values as appropriate and then clicking the ‘Save’ button.

Importing Drivers
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You can also import driver files from other loudspeaker modelling software packages (such as
WinISD) by copying them into your driver library folder. Files currently recognised are:
● *.lsd [Native Transmission Line Loudspeaker Driver File]
● *.wdr [WinISD Pro Driver Files]
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Amplifier
We are often mainly interested in the relative frequency response of our loudspeaker design.
However, the absolute sound pressure level from the speaker is obviously dependent upon the
power supplied by the amplifier. You can change the amplifier parameters by opening Amplifier
window. Click on Window > Amplifier (Ctrl+Alt+A) and the amplifier window shown below will
popup.

Re is the DC resistance of the voice coil and Rg is the resistance of everything between the
amplifier and the driver including the amplifiers output impedance and cable impedance etc.
You can then define how much power is applied by the amplifier in terms of Output Power or
Output Voltage by selecting the appropriate radial button and inputting a value into the
corresponding input box.
The other value is then calculated and displayed. Click the ‘Update’ button to apply these
changes to the current model.
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Enclosure
This program is unique in that all the design features can be accessed within the schematic
drawing. This means the controls within the schematic drawing can be used to draw the
enclosure without inputting any text at all. There are also text box inputs that can be used to
design the enclosure and sometimes these will be prefered to make quick and accurate
changes.
This software is extremely powerful and allows a huge variety of enclosure types. Any number
of segment elements can be added in series to the front and/or rear of a driver and each of
these elements can have any desired beginning and end cross sectional area, with each
element having a parabolic, conical or exponential t=1 taper. Additionally, each element can
have any number of additional elements branched off of it and those branched elements can
have any number of additional elements connected to them in series. Each element can contain
any desired density of mineral wool type stuffing material. This allows the user to simulate
almost any alignment that can be imagined, including incredibly complex geometric shapes with
any number of ports to the outside air located at any location(s) within the enclosure.
Open the Enclosure editor by selecting ‘Enclosure’ from the ‘Window’ menu. In the main window
a schematic drawing of the enclosure is displayed and the right-hand margin contains a series
of input boxes that describe the characteristics of the enclosure. The default design is an end
loaded transmission line with a taper that narrows between the driver and the terminus.
In the default schematic drawing the driver is represented by a circle and the enclosure is an
accurately scaled single segment element. Each element will have four outside boundary lines.
Solid lines represent solid boundaries and dotted lines represent an open end.

Elements
Schematic and Text Box Inputs
The first step in editing an element is selecting an element in the schematic drawing by clicking
it. Once selected the black boundary walls turn blue and the text boxes in the right margin
populate with information about the selected element. Once an element is selected it can be
edited by manipulating the schematic drawing or by using the text boxes in the right margin.
A selected element in the schematic drawing will have four red ‘handles’, two on either end of
the element. Three of these handles can be used to edit the element dimensions and the other
handle can be used to change the orientation of the element by rotating the element.
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In the picture above the red handle in the top left corner can be used to change the cross
sectional area of that end of the element. Hovering the mouse pointer over this handle will
change the cursor to an up/down arrow. Clicking and dragging the handle will resize that end of
the element and the area will be displayed in the status bar. Once released, the text boxes in
the right margin will reflect the information for the new element dimensions. The handle in the
top right corner of the selected element has the same effect on the dimensions of that end of the
element. The handle in the middle on the right side of the element can be dragged right or left
to change the length of the element.
The orientation handle, located in the middle on the left side in the picture above can be used to
rotate the element around the driver, or around the previous element if the selected element is
not the first element in a series. This does not affect the actual model and is used purely as a
visual aid when an enclosure contains many branches.
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The “Start Area”, “End Area” and “Length” text boxes in the right margin can also be used to
change the dimensions of the selected segment if text box inputs are preferred to schematic
manipulation.
Taper type can be chosen for the selected segment from the drop down box in the right margin.
Conical, parabolic and exponential can be chosen for any element.
Taper type can also be selected by right clicking a selected segment in the schematic drawing
and selecting “Taper - Conical, Parabolic or Exponential”.
Taper ratio will be calculated automatically based on the cross sectional area of the segment at
it’s ends.
The “Boundary” check-box in the right margin can be used to select an open or closed end for
the selected element. The boundary feature is also available by right clicking an element and
choosing “Boundary - Open or Closed” from the menu. This feature only applies to the last
series element and the last element in a branched series; if the selected element is not the last
series element the boundary checkbox and the boundary feature in the right click menu will be
greyed out and unavailable because only the last series element can have a closed end.
The “Stuffing” text box in the right margin can be used to specify the amount of stuffing in the
selected element. This value represents the density of a typical mineral wool type stuffing
material within the selected element.
Stuffing can also be adjusted by right clicking a selected element in the schematic drawing and
selecting “Stuffing - None, Light, Medium, Heavy or Custom.
“Model Info - Front” and “Model Info - Rear” in the right margin show cumulative depth, volume
and length of all elements connected to the front and rear of the driver.
The driver can be moved along the enclosure by clicking on, and dragging, the blue handle in
the centre of the driver. The driver can be dragged along all series elements and located
anywhere between the start and end of the line. The driver cannot be dragged onto branched
elements. The driver position can also be manually entered in the ‘Driver Pos.’ input box in the
right-hand margin.
Using the CTRL and SHIFT Keys
The CTRL and SHIFT keys can be used when manipulating the schematic drawing to toggle
auto-sizing features which can make adjusting elements quicker and easier.
When changing the length of an element by dragging the appropriate handle, holding the CTRL
key will force the element to maintain the same taper by automatically adjusting the Start Area.
Holding the SHIFT key will force the element to maintain the same taper by automatically
adjusting the End Area.
When changing the start or end area of an element, holding the SHIFT key will force the other
end of the element to have the same area causing the element to have a taper ratio of 1.
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Adding Elements
Right clicking any blank area of the schematic drawing will bring up a menu from which “Add
Rear Element or Add Front Element” can be selected. An element can also be added by right
clicking any existing element and selecting “Insert Element” from the menu. The new element
will be attached in series to the end of the selected element and will have the same taper type,
cross sectional area, length and stuffing density as the previous element.
Branches
A branch element can be added by right clicking any existing element and selecting “Add
Branch”. A new element will appear at the same starting point as the selected element. This
new element will share all the same physical characteristics as the selected element but it will
be rotated so that it’s not directly on top of the previous element. If more than one branch is
added to the same spot, subsequent elements may lay directly on top of the previous element,
but the orientation handle can be used to rotate the new element around and out of the way.
Attempting to select overlaid elements will initiate a menu asking which element to select. An
element can only spawn a single branch but multiple branches can be created in the same spot
by using each new branch to create another new branch.
Deleting Elements
An element can be deleted by right clicking it and selecting “Delete Element” from the menu. If
the deleted element is not the last series element the two adjacent elements will join. If an
element that had previously be used to create a branch is deleted it’s branches will also be
deleted.
The DEL key can be used to delete the selected element.
Copy and Pasting Elements
An element can be copied by right clicking it and selecting “Copy Element” from the menu. The
copied element can then be pasted to any element by right clicking an element and selecting
“Paste Element” and then “Paste before element, paste after element or paste as branch”.
CTRL + C and CTRL +V can also be used to copy and paste a selected element.
Reversing Elements
Right clicking an element and selecting “Reverse Element” will flip the element. The start and
end cross sectional areas will swap position and the actual taper itself will be the inverse of it’s
previous state.
The ‘R’ key can be used to reverse the selected element
Splitting and Joining Elements
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An element can be split by right clicking it and selecting “Split Element”. The selected element
will be split in half, creating two separate elements with the same cumulative properties of the
original element.
Whenever two adjoining elements can be represented by just one element then the ‘splitboundary’ between these two elements will be solid orange, indicating that they can be joined
together. This ‘split-boundary’ can be dragged to any point between the two elements. This is a
useful feature for being able quickly move a branch (which could be a port) along the enclosure.
Split elements can be joined again by right-clicking and selecting ‘Join Element’. When this is
clicked the software will attempt to replace the selected element and any adjoining elements by
a single element if possible (effectively removing the ‘split-boundary’).

Front and Rear Enclosures
Elements can be placed on either end of the driver. In the default design the single element is
on the rear. Placing elements on both the front and rear of the driver allows designs in which
the driver is enclosed on both ends like front loaded horns and bandpass enclosures to be
simulated.
By clicking the “Front” and/or “Rear” buttons located in the toolbar at the top of the Enclosure
Window all the elements on either side of the driver can be displayed or hidden. This can be
useful for complex designs in which a lot of elements are crowded around the driver.

Tapped Horn
Tapped horns can be simulated by clicking the “Tapped Horn” button in the toolbar at the top of
the Enclosure Window. This allows the radiation of both sides of the driver to enter into the
enclosure at different points in the same line. The second side of the driver is represented by a
second driver circle in the schematic drawing. This second circle also has a handle that can be
used to move the driver position. Clicking the “Tapped Horn” button again will remove the
tapped horn functionality.
A tapped horn enclosure can consist of a single element or it can be extremely complex with
several series elements and branches if desired. When the tapped horn feature is selected the
second driver circle will be placed in the first element by default but the driver can be dragged
through series elements as far as desired, anywhere from the beginning to the end of the line.

Updating the Model
There are two update modes, manual and automatic. The buttons to control these modes are in
the top toolbar of the Enclosure window. The blue wrench button toggles auto update on and
off. If this button has a blue border around it auto update is on and any changes made in the
Enclosure window or text boxes will be reflected in the analysis graphs in the main window
immediately. If the button has no border auto update is off. When auto update is off the manual
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update button must be used to prompt the analysis graphs in the main window to update. The
manual update button is a white triangle in a blue circle.

Zooming
Complex enclosures can quickly become too large to fit inside the ‘Enclosure’ display window.
To rectify this the enclosure window can be resized by dragging borders of the window or
maximised by double clicking on the windows title-bar. It is also possible to zoom in and out of
the drawing itself by scrolling the mouse wheel or by using the + and - keys on the numeric
keypad.

Enclosure Wizard
This feature can be accessed by clicking on the ‘Wizard’ drop-down button at the top of the
Enclosure Window. Selecting one of the options from the drop-down menu will automatically
create a design based on the parameters of the currently selected driver.
By no means does the wizard create fully optimal enclosures but it does give a quick and easy
starting point from which to start designing your loudspeaker system.
Please note that selecting one of the ‘Wizard’ designs will cause the current model to be
replaced. This can be undone, but the user should be careful to backup any designs they wish
to keep when using this feature.
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Filter
Electronic filters are often applied to loudspeaker systems to either protect them or to restrict
them to a particular frequency band. For example, a subwoofer might have a Low-Pass filter
applied in order to remove high-frequencies which the subwoofer will not be able to reproduce
well. High-Pass filters are also commonly applied to sub-woofers in order to protect them from
ultra-low frequencies which can cause drivers to over-exert themselves.
To apply filters open the Filter window by clicking on Window > Filter (Ctrl+Alt+F), which should
open up the following window:

You can select a Low-Pass filter and/or a High-Pass filter at either 12dB/Octave or
24dB/Octave.
The Quality Factor defines the response characteristic of the filter and represents its damping. A
value of 0.707 is common and gives the flattest response.
The Cut-Off Frequencies defines the frequency at which the filter will be providing 3dB of
attenuation.
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Result Graphs
When designing a loudspeaker, the results of the model will be displayed on the main form by
various graphs. The different graph types are grouped together into separate tabs (SPL, Phase,
Impedance, Displacement, Velocity and Group Delay).
Above the tabs are four check-boxes titled ‘Infinite Baffle’, ‘Driver’, ‘Terminus’ and ‘System’.
Selecting or de-selecting these check-boxes will show or hide the corresponding results on the
graphs.
‘Infinite Baffle’ shows the response of the driver currently being modelled when installed into an
infinite baffle (i.e. only taking into account the sound pressure from the front of the driver). This
serves a good base-line comparison.
‘Driver’ shows the response of the driver when installed in the current enclosure design. For
designs where the driver is completely enclosed (i.e. Band-Pass Boxes) there will be no Driver
response.
‘Terminus’ shows the response from the terminus (or port) of the current enclosure design. For
designs where there is no terminus (i.e. Sealed Enclosures) there will be no Terminus response.
Some complex designs may have multiple ports, in which case they will be summed together.
The exception to this is on the Velocity graphs where the air velocity at each individual port is
shown.
‘System’ shows the response from the complete system i.e. the combined response of the driver
and terminus.
Clicking on the graphs will cause horizontal and vertical lines to be drawn to the axis at the
frequency where the mouse cursor is located. The value of the various responses at that
frequency will also be displayed in the status bar of the main window. This helps with accurate
reading of the graphs.
Right clicking on any of the graphs brings up a menu allowing the graph image to either be
copied to the clipboard or saved to file in gif, jpg, png, tif or bmp format.
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Settings
Open the settings window by clicking on Tools > Settings and the following window will pop-up.

General
In the General Tab you can alter the location of your driver library and alter the history length of
the Undo/Redo.
There is no practical limit as to the amount of Undo history other than the amount of memory
that is taken up (It uses Hard Disk memory rather than working memory). A value of 5-10 is
usually sufficient.

Graphs
On this tab there are various options which allow you to personalise the axis of various graphs.
You are able to define a minimum value, a maximum value and whether the axis should be
logarithmic or not.
The default settings are usually best.
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Units
When you are designing your loudspeaker in the ‘Enclosure’ window, you are able to use the
mouse to drag and adjust the length, area and angle of each element.
In this tab you are able to define the unit that should be used when dragging elements along
with the precision that is ‘snapped’ to.

Mouse
In this tab you are able to define what mouse button is used for panning the view when in the
‘Enclosure’ window. The middle mouse button is most commonly used, however some users
(without middle mouse buttons) will want to change this.

Environment
Here you can define what value is used for the speed of sound in the models calculations.
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Updates
Updates are announced on the Leonard Audio website (http://leonardaudio.co.uk) and on twitter
(@leonardaudio).
Updates can be installed from within the software itself via the ‘About’ window. The ‘About’
window can be opened by selecting ‘Help - About’. Providing there is an internet connection the
software will check the Leonard Audio website from the latest version of the software.
If there is a newer version available then the ‘Update’ button will become enabled and clicking it
will install the latest update. Once installed the software will restart.
If the automatic update process fails then users are recommended to uninstall the software (via
the Windows Control Panel) then download and install the latest version of the software from
http://leonardaudio.co.uk
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Enclosure Design Tutorial
This tutorial shows how to fill in the text boxes and manipulate the schematic diagram to create
several popular enclosure types, step by step.
First a 1m³ sealed enclosure is shown.
The text boxes are used in this first example. “Start Area” and “End Area” are set to 1m² and
“Length” is set to 1m. 1m is also input into the “Depth” to change the schematic drawing to
accurately depict the 1 meter cube. The “Boundary” checkbox is unchecked reflecting a closed
element termination.

A port can be added to this on any of the four boundaries of this element. It could be added to
the front baffle by adding a branch, it could be added in series to the end of the existing element
by inserting a new element or it could be located anywhere along the length of the existing
element. In this case the latter is chosen in order to take advantage of the ability to move the
port location around.
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First, all three dimension handles are used to change the enclosure dimensions by clicking and
dragging the handles into an mltl shape.

After the dimensions are changed, right clicking the element and selecting “Split Element” will
split the element in half.

Then right clicking the second series element and selecting “Add Branch” will create a new
branch at the boundary between the two elements. The new branch is resized and the
“Boundary” checkbox is set to indicate an open end for this branched segment.
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In this mltl simulation the driver and the port can be moved to simulate the effect of their
locations. The driver is moved by clicking and dragging the blue driver handle, the port is
moved by clicking and dragging the orange split line between the elements. Both driver and
port can be dragged to any location between the start and end of the line.
Then the design is changed to a fourth order bandpass by adding a front chamber. Right click a
blank area of the schematic and select “Add Front Element”. Resize the new front element and
the schematic looks like this.

If desired the orientation handle (highlighted with a black circle) can be used to rotate the front
chamber so it isn’t covering another element.

Adding a port to the front chamber turns the design into a sixth order bandpass. This was
accomplished by splitting the front chamber element and adding a branch to the last series
element, the element on the far left. The new branch element is resized and the schematic now
looks like this.
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A front loaded horn is created next by right clicking both branch elements and selecting “Delete
Element”, then deleting one of the front chamber elements. The two elements on the rear side
of the driver are joined by right clicking one of them and selecting “Join Element”, or if desired
one of the elements could be used to create a throat chamber. The taper of the rear element is
changed to “Exponential” by using the “Taper Type” drop down menu in the right margin or right
clicking element and selecting “Taper - Exponential”. Finally the rear element is resized, making
the start area small and the end area large. Shown below without a throat chamber.

Changing this to an offset driver front loaded horn is as easy as using the driver handle to move
the driver so that it fires into the horn at a point further down the line.
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And then all that’s required to make a back loaded horn is to delete the front chamber element.
(Back loaded horn not shown.) To change a back loaded horn to a tapped horn click the
“Tapped Horn” button in the top toolbar.

Usually at some point it’s desirable to simulate a horn with parabolic segments so it can actually
be made with sheet goods like plywood. If the single exponential element shown above is split
into a bunch of individual elements and then each of these elements are changed to a parabolic
taper but the new series of elements will retain the original exponential taper.
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Transmission lines are easy since the default design is a tl with a negative taper. Here’s the
default design.

Right click the element and choose “Reverse Element” to easily change to a positive taper.

And of course the element start and end areas can be adjusted to make a straight transmission
line.

Stuffing can be applied in different densities in each individual element by using the “Stuffing”
text box or by right clicking an element and selecting “Stuffing - None, Light, Medium, Heavy or
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Custom”. In this picture the first half of the line is heavily stuffed and there is no stuffing in the
second half of the line.

This basic tutorial has shown how to use most of the text box and schematic window controls
and covered examples of most popular enclosure types. By using the concepts described here
experienced users can create and simulate almost any type of enclosure that can be imagined.
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Contact
Please feel free to contact us via any of the following methods:
peter@leonardaudio.co.uk
twitter@leonardaudio.co.uk
@leonardaudio
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